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1 Introduction 

This tutorial will guide designers and developers through the creation of a design prototype using 
Flowella. Flowella is a tool that enables the creation of design prototypes — without writing a line of 
code. These prototypes can be tested on devices and shared with others.  

The tutorial introduces the Flowella workflow, guides users through the steps required to create an 
interaction design flow, assign touch or click events, and transfer the completed prototype to a device. 
Customisation of the prototype’s device icon is discussed as well. 

Note: The prototype described in this tutorial is specifically designed and optimised for the Nokia 
5800 XpressMusic, but is suitable for all S60 5th Edition touch devices. A copy of the prototype’s 
source files is available for download from the Forum Nokia website. 

http://www.forum.nokia.com/info/sw.nokia.com/id/740a25d2-71c0-4031-b9b4-fdfba37157b4/Flowella_Podcast_Example_v0_9_en.zip.html�
http://www.forum.nokia.com/info/sw.nokia.com/id/740a25d2-71c0-4031-b9b4-fdfba37157b4/Flowella_Podcast_Example_v0_9_en.zip.html�
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2 Getting started 

This section provides an introduction to Flowella and describes how to install it. 

2.1 What is Flowella 

Flowella is a tool that enables designers and developers to create design prototypes — without 
writing a line of code. These prototypes can be tested on real devices, and easily shared with others. If 
you have not seen it yet, the Flowella video provides a quick demonstration of Flowella’s functionality. 

2.2 How Flowella works 

Prototypes are created in Flowella, as shown in Figure 1, as follows: 

• Use your favourite image editing software to create graphics representing each of the 
application’s views and states. 

• Drag and drop the graphics into Flowella. 

• Order the graphics to represent the application flow and then specify the touch or key press 
events associated with each view or state.  

• Create connections between these events to make your prototype interactive.  

• Once the flow is complete, test it in the desktop emulator provided in Flowella or on a device.  

 
Figure 1: The steps in creating a prototype in Flowella. 

Flowella enables creation of prototypes for both touch and non-touch devices. Prototypes can be 
tested in a desktop emulator or exported to an Adobe Flash Lite application or a Web Runtime (WRT) 
widget for testing on a device.  

http://www.forum.nokia.com/info/sw.nokia.com/id/e6eb258e-9227-411b-ac46-b140aa889634/Flowella_video.html�
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2.3 Ways to use your Flowella prototype 

As Flowella prototypes are based on images of application screens, it is most useful for prototyping 
certain aspects of your design as explained in Table 1. 
 

Design aspect Yes No Sometimes Why 

Interaction design    Flowella prototypes are ideal to quickly 
experiment with and test interaction design 
and user flow scenarios. 

Usability    Flowella prototypes are useful to test small 
specific usability scenarios. For example, quickly 
testing a feature’s discoverability or a user’s 
understanding of the steps required to 
complete a small, distinct task such as locating 
and launching a contextual menu. 

Visual design    Flowella prototypes are ideal to quickly 
experiment with, and test multiple visual 
designs on a real device. This is particularly 
useful when experimenting with the contrast 
level of a design treatment or assessing the 
impact of pixel density on your design. 

Data    As Flowella prototypes are comprised of static 
images, they are not recommended to test 
design aspects related to data—and in 
particular, dynamic data.  

Stakeholder 
presentations and 
meetings 

   Flowella prototypes are supported on close to 
70 Nokia devices. This makes them ideal for use 
as a discussion tool in meetings, informal user 
tests, or internal presentations. If exported to 
the WRT format, the prototypes become highly 
portable and easy to install—even by remote 
participants. 

Content and 
internationalisation 

   As Flowella prototypes are comprised of static 
images, they are not always ideal to test design 
aspects related to internationalisation of 
content. 

Table 1: Analysis of the aspects of a design that can be prototyped with Flowella. 

or guidelines on prototyping other aspects of your project, see the Interaction design and prototyping 
section of the Forum Nokia Design and User Experience library. 

Tip: Watch the Flowella video to discover other reasons to introduce Flowella into your product 
development process. 

http://library.forum.nokia.com/topic/Design_and_User_Experience_Library/GUID-97E4412E-180C-4058-8EBA-23F2395D0F76.html�
http://www.forum.nokia.com/Technology_Topics/Design_and_User_Experience/Interaction_design_and_prototyping.xhtml�
http://www.forum.nokia.com/info/sw.nokia.com/id/e6eb258e-9227-411b-ac46-b140aa889634/Flowella_video.html�
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2.4 What you will need 

To use Flowella, you will require the following: 

• An Apple Mac or Microsoft Windows PC compatible with Adobe AIR. If not already installed, you 
will also need to install Adobe AIR. 

• Image editing software is required to create and export your application views to PNG or JPG 
format file for use in Flowella. You can use commercial tools such as Adobe Fireworks and Adobe 
PhotoShop or free applications such as GIMP and Inkscape. 

2.4.1 Supported devices 

Flowella enables creation of prototypes for both touch and non-touch devices. Prototypes can be 
tested in the desktop emulator provided in Flowella and exported to an Adobe Flash Lite application 
or a Web Runtime (WRT) widget for testing on a device.  

You can test your prototype on any Nokia device supporting Flash Lite 3.0 or WRT 1.1. Supported 
devices include: 

• Touch S60 for Symbian — Nokia 5800 XpressMusic, Nokia N97, Nokia N97 Mini, and Nokia X6. 

• Non-touch S60 for Symbian — Nokia E52, Nokia E55, and Nokia 6710 Navigator. 

• Non-touch S40 — Nokia 6303, Nokia 3720, and Nokia 6700. 

See the Forum Nokia Devices section for a full list of devices supporting compatible versions of Flash 
Lite and WRT.  

Note: A desktop preview is also included for the Nokia N900, however it is not currently possible to 
test Flowella prototypes on this device.  

Tip: Prototypes can also be tested remotely free of charge using the Forum Nokia Remote Device 
Access (RDA) service.  

http://www.adobe.com/products/air/systemreqs/�
http://get.adobe.com/air/�
http://www.gimp.org/�
http://www.inkscape.org/�
http://www.forum.nokia.com/devices/matrix_all_1.html�
http://www.forum.nokia.com/Resources_and_Information/Explore/Development_Process_and_User_Experience/Testing/Remote_Device_Access/Instructions_for_RDA_Usage.xhtml�
http://www.forum.nokia.com/Resources_and_Information/Explore/Development_Process_and_User_Experience/Testing/Remote_Device_Access/Instructions_for_RDA_Usage.xhtml�
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3 Using Flowella 

This chapter described how to use Flowella. 

3.1 Creating the prototype views 

The first step in using Flowella is creating the prototype view; this section describes how to do that. 

3.1.1 An introduction to views and states 

Flowella prototypes consist of a collection of graphics representing your application’s views and/or 
states.  

• Views represent the different sections in your application. For example, a news application might 
have three views: the home screen, a list view (providing a list of articles), and a detail view 
representing the full content of an article. 

• States represent the changes in view that occur based on user action, such as a menu expanding 
on a tap or a key press.  

Note: States can also be related to data or network events however, as Flowella prototypes are 
comprised of static images, these types of state changes cannot typically be prototyped. 

The characteristics of an application’s views and states will also depend on the target device’s 
manipulation model. 
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3.1.1.1 Non-touch/indirect manipulation devices 

Non-touch devices require the user to manipulate interface elements through an intermediary control, 
such as a joystick. On these devices, an on-screen focus indicator is always present. This indicator helps 
users understand what user interface element is actionable. It also enables users to determine which 
keys or controls to use next and anticipate the result of these actions. How this interaction is handled 
in Flowella is shown in Figure 2. 

 
Figure 2: How the interaction seen in non-touch devices is modelled in Flowella is shown.  
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When designing for indirect manipulation, be sure to create a graphic for each focus state that you 
will require, as shown Figure 3. 

 
Figure 3: Images are required for each focus state in a prototype for non-touch devices. 

3.1.1.2 Touch/direct manipulation devices 

On most touch devices, actions are executed using a direct selection model and there is therefore no 
focus indicator. The user is free to tap, swipe, or otherwise manipulates any interface element, as 
shown in Figure 4. Once tapped, the element immediately responds with the chosen action.  

 
Figure 4: The affect of tap actions in a typical touch application is shown.  
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When designing for touch, there is consequently no need to include graphics to indicate focus. Note as 
well that Flowella does not support the chaining of events. For this reason, it is not possible to 
simulate temporary focus or press states as shown in Figure 5. 

 
Figure 5: Temporary or focus-based states cannot be simulated using Flowella. 

Note: Devices based on S60 5th Edition make use of two interaction strategies; focus and select, and 
direct selection. Additional gestures such as long-tap are supported also. Some of these gestures and 
interaction strategies cannot be simulated using Flowella. See the Touch strategies section of the S60 
5th Edition C++ Developer's Library for more information. 

3.1.2 Graphic creation tips 

This section provides tips on how to improve the quality and versatility of your view and state 
graphics. 

3.1.2.1 Graphical style can be flexible 

The graphics you use within Flowella don’t have to reflect your application’s full visual design. They 
can be rough diagrams, wireframes, or even sketches that have been scanned to produce a series of 
PNG or JPG graphics.  

http://library.forum.nokia.com/topic/S60_5th_Edition_Cpp_Developers_Library/GUID-41A36790-CB11-4620-A2D5-1981077E5753.html�
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3.1.2.2 Registration point is critical 

When representing states, be sure your graphics maintain the same registration point, as shown in 
Figure 6. This will ensure the layout doesn’t “jump around” as the prototype reveals each view 
or state. 

 
Figure 6: Each interface element is perfectly aligned to ensure visually seamless state changes. 

3.1.2.3 Create small, focussed prototypes 

Flowella is ideal for creating prototypes quickly and testing key areas of the design. Where possible, 
keep your prototypes small and focussed on one or two tasks. Consider modifying the design, as 
shown in Figure 7, to guide prototype users and clarify the areas of focus. 

 
Figure 7: Use highlighting and dimming to focus the prototype on key aspects of the design. 
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The goal of your prototype is to model the overall design rather than test the application’s 
functionality or performance. Consequently, testing every single button or control is not necessary. For 
this reason, certain menu items can be dimmed to indicate that they are inactive and better highlight 
those that aren’t.  

Tip: For a series of quick templates representing Nokia user interface components, download the 
Forum Nokia concepting and wireframing stencils. The stencils are available for touch and non-touch 
devices. 

3.1.3 Your prototype 

The application you will be prototyping is a podcasting widget for touch devices. You can download a 
copy of the prototype from Forum Nokia. The prototype will simulate the following tasks: 

1. Signing-in to the application. 

2. Viewing the list of podcasts. 

3. Filtering the podcasts to an events category, using a selection menu. 

4. Selecting a podcast from the list. 

5. Viewing the podcast detail. 

6. Rating the podcast. 

7. Performing a keyword-based search and returning a list of results. 

8. Launching the options menu and choosing to view the Settings and About screens. 

All these actions will be simulated using a collection of nine PNG graphics representing key application 
views and states as shown in Figure 8. 

 
Figure 8: The podcast widget is prototyped with nine graphics. 

3.1.4 Preparing the graphics 

Once the design of your views and states is complete, export the graphics to PNG or JPG format. To 
improve workflow, name the graphics in a sequential order that mirrors the flow being creating, such 
as 00-sign-in.png, 01-list-view.png, 02-podcast-list.png, and so on. This will make 
them easier to identify within Flowella. 

http://www.forum.nokia.com/info/sw.nokia.com/id/cf215e2d-21b9-4bb4-b8b2-4e7bd4939e90/S60_Concepting_and_Presentation_Stencils.html�
http://www.forum.nokia.com/info/sw.nokia.com/id/cfc7b6a4-2dc5-4c91-88a5-c35764fff8fe/S60_Wireframing_Stencils.html�
http://www.forum.nokia.com/info/sw.nokia.com/id/740a25d2-71c0-4031-b9b4-fdfba37157b4/Flowella_Podcast_Example_v0_9_en.zip.html�
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3.1.5 Creating the project structure 

The next step is to create the folders that will contain your project as follows. 

• Create a folder called PodcastWidget. This folder will contain the entire Flowella project. 

• Inside the PodcastWidget folder, create a second folder called Assets. Now copy and paste all 
the flow graphics into this folder.  

Now you will have the folder structure shown in Figure 9. 

 
Figure 9: The folder structure for the podcaster widget prototype. 

Note: Changing this folder structure at a later date is possible, but will involve manual editing of 
Flowella’s source XML file. For more details, see Chapter 3.6, ‘Maintaining your prototype’. 

3.2 Creating the flow 

With the assets and folder structure created, you are ready to create the flow. To do this: 

1. Launch Flowella. 

2. When asked whether you would like to create a new flow or load an existing one, choose to 
create a new flow. 

http://en.wikipedia.org/wiki/XML�
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3.2.1 Project settings 

Flowella first asks you to provide some initial project settings. These settings will determine which 
touch and key options will be available throughout the authoring process. Your prototype is a touch-
based application, so choose the Nokia 5800 XpressMusic option. Notice that once this setting has 
been chosen, as shown in Figure 10, Flowella completes the following fields for you: 

• Keypad: None 

• Cluster: Three button 

• Screen width: 360 

• Screen height: 640 

• Touchscreen: Yes 

 
Figure 10: The settings for the Nokia 5800 XpressMusic are shown. 

The settings panel offers a choice of five devices: the Nokia 5800 XpressMusic, Nokia N900, Nokia N97, 
Nokia N95, and Nokia 2710. These device profiles provide configurations to match a wide variety of 
Nokia devices, but are merely provided to facilitate workflow. Your chosen settings will not prevent you 
from testing your prototype on other similar devices. 

Example: If you choose the Nokia N95 — which includes a non-touch 240 x 360 pixel display, a 
numeric keypad, and Symbian style button cluster — you will be able to test your prototype on any 
non-touch Nokia device that supports Adobe Flash Lite 3.0 or WRT 1.1 and has a similar combination 
of screen size, keypad, and button cluster. 

 

Tip: For more details regarding the Keypad and Cluster settings, see Chapter 3.6, ‘Maintaining your 
prototype’. 
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3.2.2 Saving your work 

Once you have clicked Start Work, Flowella creates your project. Note that this project will not be 
saved until you click Save on the File menu. Doing so will first ask you to choose a name and location 
for the project. Flowella will then generate the *.flo file that contains the prototype’s structural and 
behavioural information. Figure 11 illustrates the end result. 

 
Figure 11: The folders and file created as a result of saving your project. 

Tip: The *.flo file is a simple XML file, so can be opened in any text editor. For more details 
regarding modification of the Flowella XML, see Chapter 3.6, ‘Maintaining your prototype’. 

3.2.3 Editing your initial settings  

You can change project settings at any time by clicking Edit settings on the Project menu. If you wish 
to create a prototype for a device that doesn’t match the preset values, choose Custom. You will then 
be able to enter your own combination of screen dimension, keypad, and button cluster. 

Important: Changing devices mid-project can have a dramatic effect. If, for example, your project 
includes numeric keyboard connections, switching to a QWERTY keyboard will eliminate all these 
connections. 
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3.2.4 The Flowella user interface 

Now that you have an active project, you can examine the Flowella workspace, as shown in Figure 12: 

 
Figure 12: The Flowella workspace is shown. 

The components of the Flowella workspace are as follows: 

• The library: This area displays the view and state graphics, which have been imported into 
Flowella. Graphics are displayed alphabetically and cannot be reordered. 

• The workspace: This area contains the prototype flow itself. A green ‘Start Point’ arrow indicates 
the beginning of the flow. 

• The toolbox: A floating menu, which provides easy access to the most commonly used 
Flowella features. 

• Top menu bar: This area contains the necessary commands to Save, Export and Edit Settings. 

• The preview window: This popup window enables you to test your flow using your 
desktop computer. 
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3.2.5 Importing images 

To importing images into Flowella, you drag images from the Windows Explorer or Mac Finder, 
directly into the Flowella library, as shown in Figure 13. 

 
Figure 13: Adding images to the Flowella library by dragging is shown. 

3.2.6 Managing your assets 

Once imported, a thumbnail of each image is represented within the library. A series of contextual 
options are provided to enable you to manage assets. Click on an asset in the library to enable the 
following commands: 

• Update — Using this command, you can update each asset’s source graphic. More specifically, this 
action will look for and reload any graphic of the same name, within the same source location.  

Tip: This feature can be useful in cases where your prototype was initially created using sketches or 
wireframes. As the design progresses, this feature enables you to gradually replace assets with more 
polished artwork reflecting the brand or final visual design.  

 It’s not necessary for the updated graphics to be the same size as the old ones. They should 
merely have the same file name and be in an identical location. This can be useful to create 
multiple prototypes that reflect different device screen sizes. 

• Delete — Clicking the red trash bin icon will delete an image. Images can be deleted from within 
the library or within the workspace. Each action will affect your flow as follows. 

o when deleting from the Library, Delete permanently deletes the asset from Flowella. If the 
asset is actively being used within the flow, you will be prompted to confirm the deletion. 
Once confirmed, all instances of the asset will be deleted.  

Note: Deleting an asset that is already in use can have a dramatic effect on your flow. 

o When deleting from the Workspace, the selected image only is deleted. The original asset 
remains in the library and can be used at a later date. 
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3.2.7 Creating the connections 

Now you can begin creation of the actual prototype flow.  

3.2.7.1 The start point 

Your prototype begins with the user sign-in, then the viewing the initial list of podcasts. So to begin 
the flow, drag 00-sign-in.png out of the library and into the workspace. Once provided with an 
initial image, Flowella immediately creates the first connection, as shown in Figure 14, and — as 
indicated by the green arrow provided — the official ‘Start Point’ of your flow. 

 
Figure 14: The first image having been automatically identified as the start point of the prototype is shown. 

Tip: This start point is not permanent and can easily be re-assigned. Simply grab the arrow at the end 
of the connection point and drag it to top left corner of another image within the workspace as 
shown in Figure 15. 

 
Figure 15: The start point being changed by grabbing and moving the arrow is shown. 
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3.2.7.2 The first touch-point 

Now, you can create the application’s first touch-point. Your first image represents the sign-in screen. 
Flowella prototypes don’t support text input or data access, so you will simulate sign-in with a simple 
tap of the Sign-in button. Tapping this button will load the podcast widget’s home screen (01-list-
view.png), which contains a thumbnail carousel, a list of podcasts, and a selection menu. 

To create the flow, drag 01-list-view.png onto the workspace and position it to the right of the 
initial image, as shown in Figure 16. 

 
Figure 16: Adding the second screen by dragging it in from the library is shown. 

Click to select the initial image (00-sign-in.png). Doing so will enable the close-up view, as shown 
in Figure 17. 

 
Figure 17: Close up view opened when clicking an image is shown. 
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Click and drag to form a hotspot over the Sign-in button, as shown in Figure 18. Hotspots can be 
resized and repositioned, so it’s not necessary for it to be perfectly sized the first time. 

 
Figure 18: Dragging to create a hotspot is shown. 

Roll-over the hotspot to reveal the hotspot controls. Grab the arrow located at the centre of the 
hotspot and drag it towards 01-list-view.png. Once a pink highlight appears around the 01-
list-view.png, as shown in Figure 19, the connection has been made. 

 
Figure 19: Creating a link by dragging the hotspot to another image is shown. 



 

 
 
   Flowella Tutorial                                   24 

 
Forum.Nokia.com 

 

3.2.7.3 Anatomy of a hotspot 

Now that you have the first hotspot and connection, you can examine hotspots a bit further. The 
components in a hotspot, that become visible on hover, are shown in Figure 20. 

 
Figure 20: The components in a hotspot are shown. 

These hotspot components contains are: 

• Seven resize handles: Grab any of these handles and drag to resize the hotspot. 

• A delete button: Clicking this button will delete the hotspot. If the hotspot is already connected 
to an image, the connections will be lost. 

• Connector: As described in Chapter 3.2.7.2, ‘The first touch-point’, you can drag this arrow to 
create a connection between this hotspot and any another asset. Each hotspot can support one 
connection only. To remove a connection, click the centre of the hotspot connector.  



 

 
 
   Flowella Tutorial                                   25 

 
Forum.Nokia.com 

 

• Connection hints: Once a connection has been made, rolling over the hotspot provides a series 
of hints to describe the connection, as shown in Figure 21. 

o A pink line and arrow points to the graphic the hotspot is linked to.  

Note: As the close-up view is quite large, it may not always be possible to fully see the graphic in 
question as it could be obstructed or completely covered by the close-up. To reposition the close-up, 
select and drag the grey areas of the frame. 

o A label also indicates the file name of the graphic this hotspot is connected to. 

 
Figure 21: The hints provide for a connection are shown. 
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3.2.7.4 Non-touch connections 

Within non-touch prototypes, there are no hotspots. Events are instead assigned to hardware keys, as 
shown in Figure 22. To create a key connection: 

• Click a hardware key, and then drag in the direction of the image you wish to connect to. 

• Once a pink highlight appears around the target image, the connection has been made. 

 
Figure 22: Making a connection in a non-touch prototype is shown. 
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3.2.7.5 Non-touch connection hints 

Non-touch connection hints are similar to those of touch devices, as shown in Figure. Each connection 
includes a connector handle, and similar connection hints in the form of a pink line and label. To 
delete a key connection, simply click the key itself. 

 
Figure 23: Connection hints in a non-touch flow are shown. 

3.2.7.6 Managing the workspace 

Some flows are quite linear, while others include a large number of states and dependencies. To 
improve workflow, Flowella enables you to re-arrange your workspace at any time using the 
following functionality: 

• Moving the start point — The start arrow can be repositioned at any time. Moving the arrow does 
not however affect the position of its dependent elements. If needed, these can be repositioned 
by simply selecting and dragging them. 

• Repositioning the workspace — If your flow is complex, repositioning the start point and all 
related images individually can be time consuming. In this case, it’s recommended to instead 
reposition the entire flow. You can do this by simply dragging any empty portion of the 
workspace. 



 

 
 
   Flowella Tutorial                                   28 

 
Forum.Nokia.com 

 

• Zooming — The toolbar’s Zoom In and Zoom Out controls enable scaling of the entire workspace. 
Each click of the controls zooms the workspace by a preset interval. In Figure 24, the image on the 
right represents the completed application flow when zoomed out, while the image on the left 
shows the flow at normal zoom level. 

 
Figure 24: Various levels of zooming are shown. 

• Revealing connections — There may come a time when your flow will contain so many 
connections that it will be difficult to determine their origin or destination at a glance. Flowella 
enables you to reveal each graphic’s connections by simply hovering over the image. Doing so will 
highlight connected graphics by dimming those that are not connected, as shown in Figure 25. 

 
Figure 25: The effect of hovering over an image to highlight connections is shown. 
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3.2.8 Previewing the flow 

Flowella provides a full-featured desktop preview, which can be run at any time. This preview makes it 
simple to test the prototype as you build it. To preview, simply click the Preview button located in 
the toolbox. 

Once open, the preview window, shown in Figure 26, enables you to navigate the app as you would 
on a device. 

 
Figure 26: Examples of the preview are shown. 

You can navigate the previewed prototype using the following actions: 

• With touch-based applications, simply click to simulate finger taps. 

• With non-touch applications, click the keypad or button cluster keys to simulate manipulation of 
hardware keys.  

• Click Show hit areas to toggle visual hinting of touch spots. 

• Use the Home and Back buttons for additional navigation. 

Note: The preview begins on the asset that is currently selected within the workspace. 

3.2.9 Completing the flow 

To complete the flow, continue to add graphics and create hotspot connections. While doing so: 

• be sure to test your flow periodically using the preview window. This will help determine what 
connections may be missing. 
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• remember that Flowella cannot simulate application logic. For example, your prototype contains a 
Menu button at the top left corner of most views. Opening this menu leads to the About and 
Settings views. In a real application, when a user opens then closes the Settings view, they 
should return to whatever view they were on previously. In your Flowella prototype however, 
there is no way to introduce the type of logic required to return the user to the view they came 
from. This should be handled by, for example, specifying that upon closing the Settings view, the 
prototype will display the main list view. 

• remember that you need to create hotspots for every single button or control. In your prototype, 
the Search button on views such as About and Settings is disabled. To indicate this, the buttons 
in the screen images has been dimmed to appear inactive. 

Reminder: The full *.flo source file for this prototype is available from Forum Nokia. 

3.3 Packaging and deploying the prototype 

Packaging a prototype is extremely easy. Flowella offers a choice of two output formats, as described 
in Table 2. 
 

Format Output Installation Device support 

Flash Lite 
(version 3.0 
and later) 

Outputs a collection of files, which 
includes the Flash Lite *.swf file, the 
graphics that represent your prototype 
views, and a series xml files to specify 
behaviour. 

To run the prototype, 
copy these files to a 
supported device, 
then locate and open 
the *.swf file. 

Over 50 supported 
devices. 

WRT widget 
(WRT 1.1) 

Outputs the components required to 
create a WRT widget project. Zip the 
folder and change the file extension to 
*.wgz. The widget package can be 
customised to include a custom icon, 
as described in Chapter 3.5, 
‘Customising the prototype’. 

Copy the *.wgz to a 
supported device 
then double-click to 
install.  

Over 20 supported 
devices. 

Table 2: The output formats from Flowella are described. 

For a full list of supported devices, see Devices section of the Forum Nokia website. 

3.3.1 Packaging your prototype into a Flash Lite application 

To package your prototype into a Flash Lite application: 

• on the File menu, click Export Flash. 

• select or create a folder, then click Select. 

• Flowella will export all necessary files to the folder you have specified. Using Bluetooth or a USB 
cable, copy the contents of the folder to a location of your choice on the device. 

• use the device’s File Manager to locate the folder, then click to open the *.swf file. 

To exit the prototype, press the red call termination key on your device. 

http://www.forum.nokia.com/info/sw.nokia.com/id/740a25d2-71c0-4031-b9b4-fdfba37157b4/Flowella_Podcast_Example_v0_9_en.zip.html�
http://www.forum.nokia.com/devices/matrix_flashLite3_0_1.html�
http://www.forum.nokia.com/devices/matrix_flashLite3_0_1.html�
http://www.forum.nokia.com/devices/matrix_webruntime1_1_1.html�
http://www.forum.nokia.com/devices/matrix_webruntime1_1_1.html�
http://www.forum.nokia.com/devices/�
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3.3.2 Packaging your prototype as a Web Runtime widget 

To package your prototype into a WRT widget: 

• on the File menu, click Export to WRT. 

• select or create a folder, then click Select. 

• Flowella will create a folder containing the necessary files to create a widget.  

o PC users: Zip up the ‘wrt’ folder and replace the *.zip extension with *.wgz  

o Mac users: Run the createWidget_MAC.scpt utility, which is included within the widget 
folder. This utility automates the packaging and renaming of the *.wrt archive. 
Alternatively, it can be zipped and renamed using the Get Info panel. 

• Using a Bluetooth connection or a USB cable, copy the *.wgz to your device.  

Note: Transferring the file via a Bluetooth connection is the simplest method as the file will 
immediately appear in the device’s Messaging application’s Inbox. 

• If your file is transferred via USB, use the device’s File Manager to locate it. Once the file has been 
located open it to install the widget. 

• Look for the installed widget in the device’s Applications folder. 

To exit the prototype, press the red call termination key on your device. 

3.4 Customising the prototype 

The following customisation options are specific to WRT and affect the look of your installed 
prototype within the device menu. Customising your prototype in this way can be particularly useful 
when creating large numbers of prototypes that must be easily differentiated or when sharing the 
prototype with diverse stakeholders or remote teams. 

3.4.1 Changing the name 

Flowella will assign a generic name to your widget. You can however easily change the widget name 
to suit your project. To do so: 

1. Export to WRT as usual. 

2. Before zipping the widget folder, open the info.plist file. 

3. Change both the DisplayName and Identifier text strings to reflect the desired widget 
name. Note that spaces within the Identifier string should be escaped, as shown in Example 1. 

 <key>DisplayName</key> 
 <string>Podcast Widget</string> 
 <key>Identifier</key> 
 <string>com.Podcast%20Widget.basic.widget</string> 

Example 1: Escaping spaces in the widget identifier is shown. 

Once complete, follow the steps described in Chapter 3.3, ‘Packaging and deploying the prototype’ to 
complete the packaging process. For more details on packaging widgets, see the Packaging, 
Installation and Distribution section of the Design and User Experience library.  

http://library.forum.nokia.com/topic/Design_and_User_Experience_Library/GUID-DDD362C0-DC3A-4963-8D0F-DA48C877D67A.html�
http://library.forum.nokia.com/topic/Design_and_User_Experience_Library/GUID-DDD362C0-DC3A-4963-8D0F-DA48C877D67A.html�
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Note: The *.wgz package can be renamed as you would any file or folder on your computer. Doing so 
will not affect the name that appears once the widget is installed on a device, but can be useful to 
keep track of prototype builds.  

3.4.2 Implementing a custom icon 

The current version of Flowella doesn’t enable customisation of the WRT widget icon during the 
prototype creation or export process. You can however change the icon to suit your project. To do so: 

1. Export to WRT as usual. 

2. Before zipping the widget folder, replace the icon.png file with a new file of the same name 
and dimensions. 

Once complete, zip and rename the folder per the instructions in Chapter 3.3, ‘Packaging and 
deploying the prototype’.  

For more information regarding the design and styling of icons for WRT widgets, see the Design and 
User Experience Library’s Designing the Icon, Icons, and Widget Visibility sections. 

Reminder: This process applies to WRT only. The icon cannot be changed if exporting to a Flash Lite 
application. 

3.5 Maintaining your prototype 

This chapter provides information on updating your prototype. 

3.5.1 The Flowella project structure 

Flowella project source files consist of a *.flo file and the graphics you have imported to represent 
the application’s views and states. On export, Flowella generates a series of XML files specifying the 
relationships between these graphics. All these are packaged in a folder or a WRT widget archive. 

Reminder: The *.flo file is not created automatically. Be sure to save your project as soon as you 
choose the initial settings. This will create the *.flo file and initiate the project structure.  

3.5.2 Importing a *.flo file 

You can share Flowella project files with other team members. To do so, simply forward a copy of the 
main project folder. It should contain the *.flo and the folder containing the graphics.  

Your colleagues can then import the project in one of two ways: 

• Launch Flowella 

• When prompted on startup, choose the Load option, then select the *.flo file that you wish 
to import.  

Alternatively, at any time while Flowella is open, you can click Open on the File menu, then select the 
*.flo file that you wish to import.  

Note: When sharing a project file, ensure the project structure remains the same. For example, don’t 
rename the Assets folder or remove the *.flo from the main project folder. Doing so will break the 
links located within the *.flo and prevent the project from loading as expected. 

http://library.forum.nokia.com/topic/Design_and_User_Experience_Library/GUID-C1EE1241-9466-40FB-AFED-D66B3F023596.html�
http://library.forum.nokia.com/topic/Design_and_User_Experience_Library/GUID-02FA611E-CA7B-4C05-9697-78D88695C12C.html�
http://library.forum.nokia.com/topic/Design_and_User_Experience_Library/GUID-6F86CE8D-3CAA-49E7-B899-BD589689D6CA.html�
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3.5.3 Modifying the project structure 

If needed, it’s possible to manually modify the project structure, as follows: 

1. Open the *.flo file using a text editor. 

2. Look for the <url> markup indicating the path to the graphics within your flow. 

3. Modify the paths to reflect your new project structure as shown in Example 2 and Example 3. 

<url>file:///Users/yourComputer/yourProjectFolder/Assets/yourAsset.png</
url> 

Example 2: The project graphics are in a folder called Assets. 

<url>file:///Users/yourComputer/yourProjectFolder/Images/yourAsset.png</
url> 

Example 3: The project graphics are now in a folder called Images. 

3.5.4 Updating and deleting project graphics 

Update and Delete buttons are provided for every asset in your library. For more details, see Chapter 
3.2, ‘Creating the flow’. 

If you import a *.flo that was created on a different computer or has been moved from its initial 
location, the path to the graphics will change and the Update feature will be disabled. To re-enable it, 
follow these steps: 

• Open the *.flo file in a text editor. 

• Change all image urls to relative paths as shown in Example 4, then save and close the *.flo file. 

• Open the project using Flowella then click Save on the File menu. Saving the file will 
automatically convert all the relative URL paths to absolute paths indicating the new location of 
the assets on your computer. Doing so will also re-enable the Update functionality. 

<url>Assets/yourAsset.png</url> 

Example 4: You can create a relative path to the assets folder as so: 
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3.5.5 Flowella settings 

The following settings must be specified at the start of the project. They can however be changed at 
any time by clicking Edit settings on the Projects menu. 
 

Setting Description Options 

Device Specifies the device used within the 
emulator. 

Nokia N95 

Nokia 5800 XpressMusic 
Nokia N97 

Nokia N900* 
Nokia 2710 

Custom 

Keypad Specifies the keys available when 
assigning events.  

None  
(Alpha) Numeric 

QWERTY 

Cluster Specifies the button cluster. None 
Symbian  

Three button** 
S40 

Screen width 
and height 

Specifies the size of the graphics that 
should be used to represent 
application views and states.  

Any value can be used.  
Important: To ensure the prototype works 
as expected, the size of the graphics you 
import into Flowella must however match 
the values you have specified in these 
fields.  

Touchscreen Specifies whether touch events are 
enabled. 

Boolean.  

Table 3: The settings options available in Flowella are described. 

*Note: A desktop preview is included for the Nokia N900, however it is not currently possible to test 
Flowella prototypes on this device. 

**Note: The three-button cluster is inactive and provided for reference only. See the Appendix for a 
full list of inactive keys. 

Important: Many of the above options are interdependent and will adjust depending on your choices. 
For example, if you choose a Nokia N95, the keypad and screen width/height will automatically adjust 
to match the chosen device. With the Custom device setting, you will be free to choose any 
combination of values. 
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A1 Appendix — Inactive keys 

The following keys cannot be assigned connections as their behaviour is locked to the device 
hardware. 

• Symbian for S60, S40 keys: 

o Call creation key (green ‘send’ key) 

o Call termination key (red ‘end’ key) 

o Application key 

o Clear key 

• QWERTY keys: 

o SHIFT 

o SYMBOL 

o Backspace 

o FUNCTION (Fn) 

o Ctrl 

o Chr 
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Evaluate this resource 

Please spare a moment to help us improve documentation quality and recognise the resources you 
find most valuable, by rating this resource. 

http://www.forum.nokia.com/main/1%2C%2C90%2C00.html?surveyId=75784faa-6619-4b8a-bd7d-ea7fdf9b8271/Flowella_Tutorial_v1_0_en.pdf�
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